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Preface

Scope of Manual

This manual describes the RedHawk Architect™, an easy-to-use GUI interface for
creating and maintaining a runtime and development environment for a single board
computer (SBC).

Structure of Manual

This manual consists of:

• Chapter 1, which introduces you to RedHawk Architect and guides you
through its use.

• An Index containing an alphabetical reference to key terms and concepts
and the pages where they occur in the text.

Syntax Notation

The following notation is used throughout this manual: 

italic Books, reference cards, and items that the user must specify appear in
italic type. Special terms may also appear in italic.

list bold User input appears in list bold type and must be entered exactly
as shown. Names of directories, files, commands, options and man
page references also appear in list bold type.

list Operating system and program output such as prompts, messages and
listings of files and programs appears in list type.

[] Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify these options or
arguments.

hypertext links When viewing this document online, clicking on chapter, section,
figure,  table and page number references wil l display the
corresponding text. Clicking on Internet URLs provided in blue type
will launch your web browser and display the web site. Clicking on
publication names and numbers in red type will display the
corresponding manual PDF, if accessible.

Related Publications

The following table lists Concurrent documentation for RedHawk Architect and the
components that can be installed using RedHawk Architect. Depending upon the
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document, they are available online on RedHawk Linux systems or from Concurrent’s
documentation web site at http://redhawk.ccur.com/docs.

RedHawk Architect Pub. Number

RedHawk Architect Release Notes 0898600

RedHawk Architect User’s Guide 0898601

RedHawk Linux

RedHawk Linux Release Notes 0898003

RedHawk Linux User’s Guide 0898004

RedHawk Linux FAQ N/A

NightStar Development Tools

NightView User’s Guide 0898395

NightTrace User’s Guide 0898398

NightProbe User’s Guide 0898465

NightTune User’s Guide 0898515

http://redhawk.ccur.com/docs
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Chapter 1Using RedHawk Architect

1
1
1

This chapter introduces you to the RedHawk Architect and provides instructions for its
use. 

Introducing Architect 1

RedHawk Architect is an easy-to-use GUI interface for configuring, building and flashing
embedded solutions. 

RedHawk Architect greatly simplifies the following tasks to create and maintain a runtime
and development environment for single board computers (SBCs):

• installing custom configurations of the Red Hat® Enterprise Linux®

distribution

• installing and configuring the RedHawkTM operating system

• installing SBC-specific board support packages (BSPs)

• installing NightStarTM application development tools

• maintaining and reconfiguring an SBC’s root file system

• flashing the final root file system onto a compact flash device

With Architect, you choose the Linux and application modules that will be installed with
the RedHawk kernel. For example, select networking, web server, web browser, database,
X server, minimal or all packages. Architect allows the Linux file system to be customized
and minimized for embedded applications using flash memories as small as 2 GB.

Architect creates and processes a configuration file based upon your selections and
performs actual RPM package installation. It prompts you to insert the necessary
RedHawk, Red Hat, and NightStar media depending upon the features selected.

Creating a root File System for Embedded Target Boards 1

To create a root file system that can be used on a single board computer, use RedHawk
Architect on a RedHawk or Red Hat host system to perform the following steps:

1. Create an image by selecting the software to be installed and building the
image.

2. Configure the image.

3. Customize the image for your embedded application.
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4. Flash the image to install it on your target boards.

These procedures are described in the sections that follow. The steps may be repeated to
change the image and/or flash it any number of times.

Running Architect 1

For instructions for installing RedHawk Architect, refer to the RedHawk Architect Release
Notes.

Architect must be run as the root user. 

To run Architect, type architect at a shell prompt: 

# architect 

When Architect starts, a dialog appears presenting you with the option to start a new
session or load an existing session. 

Figure 1-1  Opening RedHawk Architect Dialog

To start a new session, click on the New button. See “Creating a New Session” on page
1-3 for details.

A session can be saved at any time and loaded later to continue work on the file system
image. To edit an existing session, click on the Open button. See “Editing an Existing
Session” on page 1-35 for details.

When the Close button is clicked, the RedHawk Architect main window appears, as
shown in Figure 1-2.



Using RedHawk Architect

1-3

Figure 1-2  RedHawk Architect Main Window

Your choices are:

• start a new session by clicking on the New Session icon  or selecting
New Session  from the File  menu along the top of the window. See
“Creating a New Session” on page 1-3 for details.

• edit an existing session by clicking on the Open Session icon  or
selecting Open Session  in the File menu. See “Editing an Existing
Session” on page 1-35 for details.

Creating a New Session 1

An Architect session describes all decisions made about a particular file system image,
including: 

• the target SBC 

• which software should be installed

• how the software should be configured 
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When you select the New button from the opening Architect dialog, or the New Session
icon  or New Session  from the Fi le  menu along the top of the RedHawk
Architect main window, the New Session dialog, shown below, displays.

Figure 1-3  New Session Dialog

This dialog enables you to define the target board and its various characteristics using the
fields described below. 

Target Board

Specify the target board from the dropdown. 

Root Device

Select the root device to use on the target board from the dropdown. The
choices available depend on the board you have selected.

Root Device Size

Select the size of the selected root device that is installed on your board
from the dropdown. The choices available depend on the board you have
selected.

I/O Expansion

This section shows I/O expansion connectors that are available on the
board you have selected. For each I/O expansion connector, you may
designate an expansion module that you may have connected to it. The
choices available depend on the board you have selected.
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OK

Click on this button when all desired selections have been made. This
dialog closes and the RedHawk Architect main window is activated.

Cancel

Click on this button to cancel any changes made. The dialog closes and you
are returned to the RedHawk Architect main window.

Selecting Software to Install in the Image 1

To select the software to install in the file system image, click on Select Products from
the toolbox on the left side of the RedHawk Architect main window. This allows you
to select software from the following three groups: 

• Red Hat Enterprise Linux packages 

• RedHawk Linux operating system

• NightStar RT tools

Some initial selections are made for you by default; e.g. the core RedHawk OS.

The Estimated Image Size  gauge at the top of the RedHawk Architect  main
window indicates the approximate size the file system image will be when built. It also
indicates the percentage of the target board’s root device that will be consumed by the
image. 

Selecting Red Hat Packages 1

To select Red Hat Enterprise Linux packages for the file system image, click on the Red
Hat Packages selection from the Select Products toolbox. 

Red Hat packages may be navigated by way of several “Package Views”. Select the
desired package view from the Package Views dropdown. The following views are
available and are described in the subsections that follow.

• Embedded RedHawk Package Groups 

• Red Hat Package Groups 

• All Packages 

• Selected Packages 

Using the Embedded RedHawk Package Groups View 1

The Embedded RedHawk Package Groups view provides a view of some Red Hat
packages organized into groups. The groups of packages have been optimized for
embedded RedHawk systems and are meant to simplify the task of choosing packages for
common functionality. This view is shown in Figure 1-4.
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Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button. 

The Undo button cancels out your last select or unselect operation.

Figure 1-4  Selecting Red Hat Packages, Embedded RedHawk Package 
Groups View

Using the Red Hat Package Groups View 1

The Red Hat Package Groups view provides a view of Red Hat packages organized
in a hierarchy of groups. The package group hierachy is the standard Red Hat package
group hierachy. This view is shown in Figure 1-5.

Packages may be selected or deselected by choosing a package group in the upper pane
and then checking or un-checking packages in that group in the lower pane. All packages
may be selected with the Select all packages in group button. 

The Undo button cancels out your last select or unselect operation.
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Figure 1-5  Selecting Red Hat Packages, Red Hat Package Groups View

Using the All Packages View 1

The All Packages view, as shown in Figure 1-6, provides a linear list of all Red Hat
packages. 
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Figure 1-6  Selecting Red Hat Packages, All Packages View

Packages may be selected or deselected from this list. The Show only packages
matching box allows you to search for packages by name.

All packages can be selected by clicking on the Select all packages button.

The Undo button cancels out your last select or unselect operation.

Using the Selected Packages View 1

The Selected Packages view, as shown in Figure 1-7, provides a linear list of all Red
Hat packages that are currently selected for installation. 
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Figure 1-7  Selecting Red Hat Packages, Selected Packages View

Packages may be deselected from this list. The Show only packages matching box
allows you to search for packages by name. 

To include the required packages in the list, check the Show required packages
checkbox. When this box is unchecked, only the optional packages are shown.

The Undo button cancels out your last select or unselect operation.

Selecting RedHawk OS Options 1

To select RedHawk Linux OS and kernels for the file system image, click on the
RedHawk selection from the Select Products toolbox. The RedHawk page, shown in
Figure 1-8, displays.
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Figure 1-8  Selecting RedHawk Options

The Core OS product is required and cannot be deselected. Other RedHawk products
will be available in future releases.

Select which RedHawk kernel(s) to install by checking the appropriate checkbox(es):
Standard, Trace and/or Debug. 

Selecting NightStar RT Options 1

To select NightStar RT tools for the image, click on the NightStar selection from the
Select Products toolbox. The NightStar page, shown in Figure 1-9, displays.
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Figure 1-9  Selecting NightStar Tools

Each NightStar tool is described in the righthand side of the page. 

Click on the Servers Only radio button to indicate that only NightStar servers are to be
installed in the image. You may select individual servers from the list by clicking on the
checkboxes for each tool.

Click on the Full Tool Set radio button to indicate that NightStar servers and clients are
to be installed in the image.

Configuring an Image (before building) 1

It is now possible to pre-configure a file-system image before the image has been built by
selecting the first Configure Image from the toolbox on the left side of the RedHawk
Architect main window. This section is only enabled before the build, and is identical to
the steps described in configuring the image after the build, with the exception that there
are no Apply buttons on these pages. See “Configuring an Image” on page 1-17 for more
information.
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Building an Image 1

To build the file system image by installing the selected software, select Build Image
from the toolbox on the left side of the RedHawk Architect main window. The Build
Image page shown in Figure 1-10 displays.

Figure 1-10  Build Image Page

Choose a directory in which to build the file system image and enter it in the Target
Directory field, or click on the Change button to display a file browser from which to
choose.

NOTE

Do not use /tmp as the image file directory. Packages like “tmp-
watch” might remove files that have not been accessed in a certain
number of days, thereby sabotaging the image directory.
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Choose a name for the file system image and enter it in the Image Name field.

NOTE

Make sure that the directory you specify has enough free disk
space to hold one or more file system images, each of which can
be several gigabytes in size.

Click on the Build button to begin the build process. The rest of this section assumes that
you have not previously ripped the ISOs from their respective media by clicking on the
Rip ISOs from media button. Advanced users may wish to do that to avoid inserting
DVD or CD media repeatedly, however that process is not covered in this document.

Dialogs are presented to guide you through the process of installing the software into the
image. For example, you will be prompted to insert various DVD or CD media, as shown
in Figure 1-11. Follow the directions to load the media, then click OK to begin. 

Figure 1-11  Build Prompt to Insert RHEL Media

When OK is selected, the RHEL installation begins. The Build Image screen overlays
the RedHawk Architect  main window and tracks the progress, as shown in Figure
1-12. 

Clicking Abort at any time in the build process aborts the build. A confirmation message
then displays and you must click on the Close  button to close the message box and
reactivate the RedHawk Architect main window. 
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Figure 1-12  Status of RHEL Installation

A progress bar at the top of the Build Image screen shows the progress of the RHEL
installation from the media.

A progress bar in the lower half of the screen tracks the progress of the complete build
process, including installation of remaining packages. The progress bar can be changed to
an “error log” using the View dropdown. Status messages display in the lower pane.

View

When Status is selected, the Overall Progress displays as a progress bar.
When Error Log  is selected, overall progress displays as an error log,
which shows any error messages generated by the build process.
Regardless of the View setting, critical error messages result in pop-up
error dialogs with which you can interact.

Abort

Click on this button to abort the build. A confirmation dialog displays
allowing you to confirm or decline aborting the build process.

Close

Once the build is completed or aborted, click on the Close button to close
the Build Image screen and reactivate the RedHawk Architect main
window.
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When the RHEL installation is complete, the dialog shown in Figure 1-13 appears. 

Figure 1-13  Build Prompt to Insert RedHawk Media

Load the RedHawk Linux media, then click OK. The RedHawk installation begins and
the Build Image screen tracks the progress, as shown in Figure 1-14.

Figure 1-14  Status of RedHawk Installation



RedHawk Architect User’s Guide

1-16

When the RedHawk installation is complete, the dialog shown in Figure 1-15 appears. 

Figure 1-15  Build Prompt to Insert NightStar Media

Load the NightStar media, then click OK to begin. The NightStar installation begins and
the Build Image screen tracks the progress, as shown in Figure 1-16.

Figure 1-16  Status of NightStar Installation

When all software is installed, the completion message shown in Figure 1-17 appears. 
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Figure 1-17  Build Completed Successfully Message

Click OK in the Build Status dialog, then click Close on the Build Image screen to
close it and reactivate the RedHawk Architect main window.

Configuring an Image 1

To configure the file system image, select Configure Image from the toolbox on the left
side of the RedHawk Architect  main window. This allows you to configure the
following three groups: 

• General Settings 

• Console 

• Networking 

Some initial selections are made for you by default. 
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Configuring General Settings 1

To configure time zone, root password and default system run level for the file system
image, click on General Settings from the Configure Image toolbox. The General
Settings configuration page appears, as shown in Figure 1-18.

Figure 1-18  General Settings Configuration Page

In the Time Zone  section, select the proper time zone for your location from the
dropdown. Click in the checkbox to indicate if your system clock uses UTC.

In the Root Password section, enter the root password in the Password field. Reenter
it in the Confirm Password field. 

In the Run Level section, select the desired default run level from the dropdown. 

When all entries are complete, click on the Apply general settings... button to apply
the settings to the image.
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Configuring a Console 1

To configure a serial console for the file system image, click on Console  from the
Configure Image toolbox. The Console Configuration page appears, as shown in
Figure 1-19.

Figure 1-19  Console Configuration Page

Click on the Configure a serial console checkbox to activate the fields that define the
port and baud rate for the console.

Select a port from the Serial Port dropdown.

Select a baud rate from the Baud Rate dropdown.

When all selections have been made, click on the Apply console settings... button to
apply the settings to the image.
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Configuring Networking 1

To configure networking for the file system image, click on Networking from the
Configure Image toolbox. The Network Configuration page appears, as shown in
Figure 1-20.

Figure 1-20  Network Configuration Page

All available network devices are listed in the Devices section.

To configure a particular network device, click on the device to select it, then click on the
Edit Device Configuration button. The Configure Network Device dialog shown
in Figure 1-21 displays.



Using RedHawk Architect

1-21

Figure 1-21  Configure Network Device Dialog

The selected network device is displayed at the top of the dialog.

Click on the Enabled On Boot checkbox to enable/disable the device automatically on
boot. 

Select Dynamic or Manual IP address configuration by clicking on the appropriate radio
button. For manual configurations, enter the IP address and netmask in the appropriate
fields.

Click on OK to apply the settings to the image and close the dialog. Click Cancel  to
cancel changes.

On the Network Configurat ion  dialog (Figure 1-20) in the Miscel laneous
Settings area, supply the hostname, default gateway, domains, primary and secondary
DNS server addresses in the appropriate fields.

When all selections have been made, click on the Apply network settings... button to
apply the settings to the image.

Customizing an Image 1

To further customize the file system image, select Customize Image from the toolbox
on the left side of the RedHawk Architect main window. This allows you to customize
the following four groups: 

• Kernel Manager

• Additional RPMs
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• File Manager

• Chroot Shell 

Each of these customizations will be fully described in the following sections.

Kernel Manager 1

To customize kernel settings for the file system image, click on Kernel Manager from
the Customize Image  toolbox. The Kernel Manager  page appears, as shown in
Figure 1-22

Figure 1-22  Kernel Manager Page

The Kernel Manager  allows you to perform different functions with the kernel
configuration in the target image. 

The Kernel to Boot area allows you to choose which installed kernel should be the
default kernel that boots in the target image. Any change made to this setting is
customized in the target image immediately.
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The Custom Kernel Operations area contains several different functions related to
configuring and building custom kernels for the target image. These functions will be
described in the following sections.

Note that only one custom kernel configuration, and therefore one custom kernel, can be
associated with a specific target image at any given time.

Configure Custom Kernel 1

The Configure Custom Kernel button begins the process of creating a custom kernel
configuration. The custom kernel configuration is based upon the kernel configuration that
is selected in the dropdown menu that is immediately to the right of the Configure
Custom Kernel button.

The choices in the dropdown are: Static, Trace-Static, Debug-Static and Custom.
The first three create new configurations based on the configurations of the standard
RedHawk kernels. The Custom  choice bases the new configuration on the current
custom kernel configuration that is associated with the image; thus, the Custom choice
can be used to further customize a configuration that you have already customized or
imported.

Pressing the Configure Custom Kernel  button will bring up two different dialog
windows. The first dialog window displays overall configuration progress status, as
shown in Figure 1-23.

Figure 1-23  Custom Kernel Dialog
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This window shows the status of running the ccur-config command in the target
image kernel source directory. The ccur-config command will eventually bring up the
Linux Kernel Configuration window to customize the kernel, as shown in Figure
1-24.

Figure 1-24  Linux Kernel Configuration Dialog

This window allows you to customize almost any aspect of the custom kernel
configuration. It is expected that users who are performing this step have a thorough
understanding of Linux kernel configuration.

Note that you must Save the kernel configuration before you exit the Linux Kernel
Configuration window. Failure to Save the configuration will result in an error being
displayed in the Custom Kernel Manager  dialog window and no changes to the
custom kernel configuration will be made.

Import Kernel Configuration 1

The Import Kernel Configuration button allows you to choose a configuration file on
the host system and import it to become the custom kernel configuration in the target
image.

Note that once a custom kernel configuration has been imported you can further customize
it by using the Configure Custom Kernel button and selecting the Custom kernel to
base the configuration on.
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Export Kernel Configuration 1

The Export Kernel Configuration button allows you to copy the target image’s
current custom kernel configuration to the host system.

Build Custom Kernel 1

The Build Custom Kernel button allows you to build a complete and installed custom
kernel in the target image. You must first have created a custom kernel configuration,
either by using the Configure Custom Kernel button or by using the Import Kernel
Configuration button.

Building a custom kernel compiles each file that comprises the Linux kernel and this
process can take quite a bit of time to complete. Once you start the process, you will see
the Custom Kernel Manager  dialog appear, as shown in Figure 1-25 and it will
describe the entire process.

Figure 1-25  Initial Build Progress

Initially ccur-config will be invoked and once that completes the kernel build stages
will begin, as shown in Figure 1-26.
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Figure 1-26  Kernel Build Stages

Finally, once the entire build and install process is complete, the kernel source tree will be
cleaned to free up the temporary space used to build the kernel. At this point the entire
build process will be complete, as shown in Figure 1-27.
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Figure 1-27  Kernel Build Complete

The custom kernel automatically becomes the default kernel to boot. If this choice is not
desired, change the kernel to boot using the Kernel To Boot area as described above.

Remove Custom Kernel 1

The Remove Custom Kernel button allows you to remove the current custom kernel
from the target image. This will remove the entry in grub.conf as well as all of the
associated kernel files in the image.

Note that the custom kernel configuration itself is not removed. Thus, it is still possible to
build a custom kernel based on the current custom kernel configuration that still remains
in the target image.

Additional RPMs 1

To install additional RPMs into the target file system image manually, click on
Additional RPMs  from the Customize Image toolbox. The Install Additional
RPMs page appears, as shown in Figure 1-28.
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Figure 1-28  Install Additional RPMs Page

The Install Additional RPMs page can be used to locate RPM files on the host system
and then easily install them into the target file system image. Note that the interface
supports multiple selection; if you have a set of RPMs that have dependencies upon each
other you will need to select all of the RPMs simultaneously to have them properly
installed together into the target file system image.

File Manager 1

To copy various files into the target file system image manually, click on File Manager
from the Customize Image toolbox. The File Manager page appears, as shown in
Figure 1-29.
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Figure 1-29  File Manager Page

The File Manager page supports many features including multiple selection, the ability
to create new directories in the target file system image, and the ability to delete files in
the target system image.

Chroot Shell 1

To customize the target file system image manually, click on the Chroot Shell from the
Customize Image toolbox. The Chroot Shell page appears, as shown in Figure 1-30
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Figure 1-30  Chroot Shell Page

From this toolbox you can open a “chroot” shell in a terminal window. Select the type of
terminal from the dropdown and click on the Run button. A terminal screen opens, as
shown in Figure 1-31
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Figure 1-31  chroot Shell

This provides a shell with the root directory being the file system image directory. All
changes made to system files (including software installed or removed) will be done in the
file system image directory only. The host’s root file system will not be affected.

Exit the shell when changes are complete.
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Flashing an Image 1

To copy a target root file system image to a CompactFlash device, select Flash Image
from the toolbox on the left side of the RedHawk Architect main window. This will
display the Flash Image page, as shown in Figure 1-32.

Figure 1-32  Flash Image Page

The Flash button allows you to copy a root file system image onto a CompactFlash that is
connected directly to the host machine via a USB-to-CompactFlash adapter. Note that
IDE/SATA CompactFlash adapters are not supported at this time.

CompactFlash devices can be bought inexpensively at many retail stores that sell
computer accessories. Note that the duration of the flashing process depends upon the
performance rating of the specific CompactFlash device. It is recommended to use
CompactFlash devices that have a minimum of a 40MB/s read/write performance rating.

Pressing the Flash  button will begin copying the target root file system onto the
CompactFlash device by bringing up the Flash Image dialog, as shown in Figure 1-33.
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Figure 1-33  Flash Image Dialog

The host system will now be scanned for attached CompactFlash devices and a choice will
be presented to the user, as shown in Figure 1-34.

Figure 1-34  Flash Destination Choice

Press OK to choose the appropriate device, confirm the operation one last time and then
the copy will begin, as shown in Figure 1-35.
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Figure 1-35  Flash Copy Begins

Note that no initial check is made to determine whether the image will fit onto the size of
the selected CompactFlash device. If the copy fails because of insufficient space, an error
message will be displayed, as shown in Figure 1-36.

Figure 1-36  Flash Dialog Error

If the CompactFlash is large enough to hold the image, and no other error occurs during
the copy, a success dialog will be presented, as shown in Figure 1-37.
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Figure 1-37  Flash Copy Completed

Once the copy has completed successfully the CompactFlash can then be placed onto the
intended target board and the board can be reset to boot into a fresh RedHawk installation.

Editing an Existing Session 1

A session can be saved at any time and loaded later to continue work on a file system
image.

To save the current session click on the Save Session icon  or on Save Session in
the File menu. Selecting the Save As icon  or Save Session As in the File menu
displays a file selection dialog.

NOTE

Performing a Save Session As will not save any associated
image path with the session file. This is useful for cloning ses-
sions to be used to create multiple images. Always use Save
Session if you want the image path to be saved in the session
file.

To load an existing session, click on the Open Session icon  or on Open Session in
the File menu. You may also click on the Open button from the opening dialog when
Architect first starts.
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Updating Software with NUU 1

Concurrent’s Network Update Utility (NUU) is a graphical user interface which allows
you to install, update and remove RPM packages on a system. The packages are
downloaded from a remote yum repository. For more information about NUU, see
http://redhawk.ccur.com/updates/index.html.

NUU may be used to maintain the software installed in a file system image. NUU is an X-
based application. Running X applications under a chroot shell requires the following
special X configuration on the host system:

1. Run the gdmsetup command and uncheck the box that reads “Deny TCP
connections to Xserver” under the “Security” tab.

# gdmsetup

2. Restart the X server:

# killall Xorg

3. Run the command:

# xhost +

http://redhawk.ccur.com/updates/index.html
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